Change your desktops, change your business

Lower IT costs and boost employee productivity for a competitive edge

Do more with faster Pay less for power Make IT more effective Leverage the newest
performance technology

Promote productivity with Save at the outlet with up Lower repair costs and Give employees the benefits
up to 145% better system to 60% fewer watts at idle reduce employee downtime of touch, more connectivity

performance and up to 42% fewer watts with out-of-band support options, fewer wires, and
under load more workspace

*comparing a new All-in-One PC or Mini Desktop to a legacy desktop tower

Your business faces a difficult decision with an aging desktop fleet. You
ultimately have two choices: You can replace the systems now, or you can push the
capital expense to the next fiscal year. How do you know when it’s the right time to
invest in a boost for your business?

To help you make the best decision, we compared two new desktops powered
by Intel processors—an All-in-One PC and a Mini Desktop—to a five-year-old legacy
desktop tower much like the ones your business might have in place. With thorough
hands-on testing and research, we looked at the benefits that replacing the systems
could provide for your business when it replaces a fleet of legacy desktop towers with
new All-in-One PCs or Mini Desktops.

Your employees have the opportunity to be more productive with faster and
more reliable new desktops. New desktops are also more efficient, and your business
can realize significantly lower power costs. By leveraging both improved and new
technology, IT staff and users benefit from simplified, out-of-band management while

gaining advantages in connectivity and workspace savings.
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ENABLE EMPLOYEES TO DO MORE WITH FASTER SYSTEMS

Promote productivity with up to 145% better system performance

Waiting on a slow PC can be painful. A faster, more responsive desktop means
your employees can finish the same tasks in less time, ultimately providing your
employees an opportunity to be more productive. We used five industry-standard
benchmarks to show the performance boost your employees can get with a new Intel
processor-based All-in-One PC or Mini Desktop. The new Intel processor-powered
desktops outperformed the legacy desktop tower on all of the performance
benchmarks.

For detailed specifications of the test systems, see Appendix A. For step-by-step
details on how we performed our benchmark testing, see Appendix D. For more on the
benchmarks, see Appendix E.

As Figure 1 shows, we found the All-in-One PC and Mini Desktop provided
significantly better system performance than the legacy desktop tower—145 percent
and 114 percent, respectively. Note: We calculated the percentage wins for the All-in-
One PC and Mini Desktop on each benchmark, and then calculated system performance
by taking the geometric mean of those percentage wins versus the legacy desktop
tower. For more details on how we calculated the system performance, see Appendix B.

Increase performance
with new desktops

Figure 1: System performance All-in-One PC
improvement for the All-in-One PC

and Mini Desktop vs. the legacy

desktop tower. Higher numbers are

better.
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Faster desktops for your
employees mean less
waiting while working
and an opportunity for
increased productivity.

.

Figure 2: Time saved in hours over
four years when replacing a fleet of
legacy desktop towers with All-in-

One PCs.

So what does better system performance mean for your business? If your
average employee spends 10 minutes a day waiting to do the types of tasks included in
our benchmarks, 145 percent better system performance means your average
employee could save almost 6 minutes per day or 23 hours per year when moving from
the legacy desktop tower to the All-in-One PC. As Figure 2 shows, replacing desktops
represents a significant opportunity for increased productivity as the size of the desktop
fleet increases. For example, a business replacing 10,000 legacy desktop towers with
10,000 new All-in-One PCs could see significant savings over four years—5.923 minutes
saved daily per employee would add up to over 900,000 total hours saved that

employees could use for other tasks.! 2

Promote productivity by replacing desktops
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PAY LESS FOR POWER WITH MORE EFFICIENT SYSTEMS

Save at the outlet with up to 60% fewer watts at idle and up to 42% fewer watts under load

The All-in-One PC and
Mini Desktop consumed
less power under load
than the legacy desktop
tower consumed at idle.

Why waste energy and dollars with inefficient older desktops? We found that
both the All-in-One PC and Mini Desktop consumed significantly less power than the
legacy desktop tower—and notably, consumed less power under load than the legacy
desktop tower consumed at idle. The All-in-One PC consumed 55 percent fewer average
watts while idle and 35 percent fewer average watts under load than did the legacy

desktop tower. The Mini Desktop consumed 60 percent fewer average watts while idle

1 Based on a conservative estimate that a hypothetical mix of productivity tasks would take an average of 10 minutes per employee
per day with the legacy desktop tower. With 145.3 percent better system performance, the same mix of tasks would take an average
of 4.077 minutes per employee per day with the All-in-One PC, saving 5.923 minutes per employee per day.

2 Based on a 46-week work year per employee, which includes holidays, vacation, and sick leave (www.bls.gov/opub/btn/volume-
2/paid-leave-in-private-industry-over-the-past-20-years.htm).
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and 42 percent fewer average watts under load than did the legacy desktop tower.

Figure 3 shows the power usage of all three systems while idle and under load.

Increase power efficiency
with new desktops
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As Figure 4 shows, replacing older inefficient desktops can significantly affect
the bottom line. For example, a business replacing 10,000 legacy desktop towers with
10,000 new Mini Desktops could realize significant savings over four years—$7.65 saved
annually per employee would add up to $306,000 total savings in power costs.3

Save at the outlet by replacing desktops
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Figure 4: Power consumption savings

in dollars over four years when
replacing a fleet of legacy desktop
towers with Mini Desktops.
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3 Based on a conservative estimate of one hour under load and seven hours idle for average power consumption per employee per
day, 46-week work year per employee, and average US commercial power costs of $0.1075 per kilowatt-hour from the U.S. Energy
Information Administration (www.eia.gov/electricity/monthly/pdf/epm.pdf).
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MAKE IT STAFF MORE EFFECTIVE AND KEEP BUSINESS RUNNING

Lower repair costs and reduce employee downtime with out-of-band support

/New desktops with the
latest Intel technology
can enable your IT to
support more systems
remotely instead of
making expensive

\deskside visits.

~N

J

Replacing desktops can also enable IT to lower costs, reduce employee
downtime, and support more systems. The All-in-One PC and Mini Desktop in our study
included the latest Intel vPro™ technology and the latest version of Intel Active
Management Technology (Intel AMT).? The legacy desktop tower in our study shipped
with an older release of Intel AMT (5.2), which meant that it did not support hardware-
based Keyboard-Video-Mouse (KVM) Remote Control.”

With a fleet of new All-in-One PCs or Mini Desktops, your IT staff can access the
graphical user interface (GUI) and control desktops remotely—regardless of power
state. For non-operational desktops that are out-of-band, IT staff can resolve some
problems remotely that previously would have required an expensive deskside visit with
a fleet of legacy desktop towers. The travel time for deskside visits with legacy desktop
towers ultimately increases the cost for IT to make repairs and increases the amount of
employee downtime and lost productivity. In our testing, it took only 15 seconds to
launch a KVM session on either the All-in-One PC or Mini Desktop, which translates to
significantly less overhead for your IT staff.

The ability to use KVM Remote Control to support non-operational systems
provides the following advantages for your IT:

e Fewer truck rolls to remote sites — IT can spend less time behind the wheel. For
example, MSPs have reported a 90 percent reduction in deskside visits per
month to a typical customer when they use KVM Remote Control to support
Intel vPro systems.®

e Reduce time to fix non-operational systems — IT can diagnose and fix non-
operational systems more quickly using KVM Remote Control, which can mean
more time for other tasks.

e Fix hardware problems in one visit instead of two — IT can diagnose problems
with KVM Remote Control and deploy a technician with parts, rather than one
visit for diagnosis and a second visit to make the repair.

o Reduce downtime for your employees — Faster problem resolution ultimately
means less lost productivity with less downtime for your employees.

Figures 5 through 8 illustrate potential savings for your business with a single

support call for a non-operational system. In this scenario, an employee at a remote site

calls the help desk to report a problem with her desktop, which is non-operational with

4 For more information on Intel AMT, visit www.intel.com/content/www/us/en/architecture-and-technology/intel-active-
management-technology.html?wapkw=amt.

Ssoftware.intel.com/sites/manageability/AMT Implementation _and Reference Guide/default.htm?turl=WordDocuments%2Fkvma

ndintelamt.htm

bBased on field testing: msp.intel.com/assets/CircleComputerResourcesCS.pdf
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a critical failure; IT would need 10 minutes to resolve the problem with KVM Remote
Control session or a deskside visit.

Figure 5 illustrates the potential savings for employee downtime with the All-in-
One PC or Mini Desktop. With the legacy desktop tower in this scenario, the employee
would have to wait until the following business day for a deskside visit, representing
eight business hours of downtime after the initial call. With the All-in-One PC and Mini
Desktop, the employee would have to wait only 15 seconds for IT to initiate the KVM
Remote Control session.” In this scenario, replacing desktops would enable IT to reduce

employee downtime by almost eight business hours for a single repair.

Reduce employee downtime
with new desktops

Lost
. . . productivity 0:10:15

Figure 5: Lost productivity due to due to

employee downtime with a non- employee

operational system, in hours. Lower downtime for 8:10:00
numbers are better. a repair

Time (hours:minutes:seconds)
m All-in-One PC and Mini Desktop Legacy Desktop Tower

with KVM Remote Control with deskside visit

Replacing desktops would enable IT to reduce employee downtime significantly
when supporting non-operational systems like the one in our scenario. Instead of
waiting eight business hours for the repair, employees would be able to get back to
work much sooner with a faster resolution of the critical software problem. Figure 6
shows the value of the reduced employee downtime with the All-in-One PC or Mini
Desktop. The All-in-One PC or Mini Desktop would reduce the cost of employee
downtime by $215.08 for the 10-minute software repair—a savings of nearly 98
percent.®

7 We assumed an equal amount of time for IT to generate the support ticket with KVM Remote Control and the deskside visit, and
did not include that time in our analysis. We also assumed that the employee was unproductive while IT staff completed the repair.
8 We estimated an average end-user cost of $.4483 per minute, based on an average annual total compensation of $55,954.00,
which includes an average 2013 US salary of $43,041.39 (www.ssa.gov/OACT/COLA/AWI.html) plus 30 percent in benefits.
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Figure 6: Cost of lost productivity due
to employee downtime with a non-
operational system, in US dollars.
Lower numbers are better.
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Figure 7 illustrates the potential savings for IT labor with the All-in-One PC or

Mini Desktop. With the legacy desktop tower in this scenario, IT would see significantly

more overhead with one hour of total travel time to and from the remote site for the
deskside visit. With the All-in-One PC or Mini Desktop, IT would have only 15 seconds of
overhead equal to the time it would take to initiate the KVM Remote Control session.

Replacing desktops would enable IT to reduce the time required to complete the repair

by almost one hour in this scenario.

Figure 7: IT labor to repair a non-
operational system, in hours. Lower
numbers are better.

Reduce IT labor
with new desktops
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IT labor for
a repair
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m All-in-One PC and Mini Desktop Legacy Desktop Tower
with KVM Remote Control with deskside visit
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Reducing the amount of time IT staff need to repair non-operational systems
can enable IT to support more systems and complete other tasks. Figure 8 shows the
value of the time IT could save by replacing legacy desktop towers with new desktops.
The 10-minute software repair would cost $39.65 less with the All-in-One PC or Mini

Desktop due to the elimination of travel time—a cost savings of 85 percent.’

Lower costs with reduced IT labor

by replacing desktops
Cost of IT staff 56.80

Figure 8: Cost of IT labor to repair a osto @

. X labor for a
non-operational system, in US repair
dollars. Lower numbers are better. $46.45

Dollars (US)
m All-in-One PC and Mini Desktop Legacy Desktop Tower
with KVM Remote Control with deskside visit

Reduce repair costs

An aging desktop fleet ultimately means that your IT staff and employees are
using systems that are less reliable. Compared to new desktops, IT can spend more time
to support or repair the aging systems and users can see more downtime.

We looked at several studies that compared repair rates for older and newer
systems. They showed different failure rates in specific years, but they all suggested that
costs trend upwards as systems age, indicating that businesses could see lower repair
rates and costs for the All-in-One PC and Mini Desktop compared to our legacy desktop
tower. For example, an Intel TCO analysis shows desktop failure rates of just 3 percent in
the year three of ownership, 10 percent in year four, and 18 percent in year five.

Older systems like the legacy desktop tower can add more repair costs when
they happen outside the original three-to-five year OEM warranty period. Once older
systems are out of warranty, businesses can assume repairs internally or purchase out-
of-warranty coverage from the OEM or a third party—both at a cost. Internal repairs

add costs for parts, desktop support staff to diagnose and repair problems, and parts

9 We estimated an IT cost of $.6635 per minute, based on an average annual total compensation estimate from Salary.com of
$82,809 for a Help Desk Support senior-level position.
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inventory management. Dell estimates that a service repair not covered by warranty can
cost between $150 and $699.1° Much of the cost for out-of-warranty repairs comes
from parts—a replacement hard drive for the legacy desktop tower could cost $90 or
more,*! and costs to replace multiple parts on a system can exceed $600.?

The alternative of extending warranty coverage from the vendor would add
$119 per year per system for the legacy desktop tower in this study.!* Extended
warranties, however, are ultimately an imperfect solution. Some vendors limit extended
coverage to within the first three to five years from the date of purchase, and might not
provide coverage for a legacy system the age of the one we studied.* Extended
warranties also do not cover all repair costs, leaving businesses to pay for some costs
out of pocket. For example, parts coverage in the extended warranty for the legacy
desktop tower in our study “is limited to one major part per product per 12-month

period commencing from the Care Pack start date.”*”

LEVERAGE THE NEWEST TECHNOLOGY

Gain the benefits of touch
Touch-interactive technology is becoming as popular in the office as it is at
home. An Intel study shows respondents overwhelmingly preferred laptops with

touch,® and shipments of touchscreen monitors are seeing growth.”
If a touchscreen delivers Microsoft® Windows® 8.1 does not require touch technology, but a touch-
a productivity benefit of
one minute per day
with the All-in-One PC,
it could pay back its

enabled version of the operating system can allow users to access information,
collaborate, and make presentations through quick touch gestures. For the All-in-One PC

with the included touchscreen display, users can engage content such as Web pages,

added cost in under 20 images, videos, pdfs, and email with touch-enabled apps such as Microsoft Office 365™,
months. and then switch to the keyboard and mouse for typing and editing content, choosing the
\ / more comfortable interface for each task.

10 www.dell.com/content/topics/segtopic.aspx/service _ext warranty?c=us&l=en&cs=19

11 Based on the price of an individual drive of the model on the legacy desktop tower
www.newegg.com/Product/Product.aspx?ltem=9SIA6752G40001

12 www.zdnet.com/article/pc-laptops-and-accidental-damage-best-and-worst-warranties-2014/

13 Cost for HP 1y PW 4h 9x5 LE-Desktop CPU HW Support - LE-Desktop CPU Only onsite response, 8am-5pm - standard business days
excluding HP holidays h30094.www3.hp.com/product/sku/2551404/mfg partno/U4858PE

14 www.dell.com/learn/my/en/mydhsl/campaigns/warranty-extension-sg

15 h30094.www3.hp.com/product/sku/2551404/mfg_partno/U4858PE

16 www.neowin.net/news/intel-80-percent-of-pc-users-prefer-touch-screens and www.intelfreepress.com/news/do-people-want-
touch-on-laptop-screens/197/

7 www.businesswire.com/news/home/20141215006340/en/Worldwide-PC-Monitor-Market-Aided-Touch-Screen#.VJPVgCsgBg
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For the All-in-One PC that we tested, the touch-enabled display added $186 to
the starting price over a similarly configured model without touch.®® If the touchscreen
on the All-in-One PC can deliver a productivity benefit of just one minute per day, the

optional touch capability could pay back its added cost in under 20 months.* 2°

Connect via USB 3.0, DisplayPort, HDMI, and Wireless AC

Replacing desktops can enable your business to take advantage of the latest
USB technology. The All-in-One PC and Mini Desktop included USB 3.0 ports—eight and
six, respectively. The legacy desktop tower offered USB 2.0 ports. USB 3.0 ports, such as
those on the two Intel processor-powered desktops, can provide up to 4.8 Gbps transfer
rates to USB 3.0 devices—up to 10 times faster than the transfer rate for USB 2.0
connections to USB 2.0 devices that you could get with the legacy desktop tower.

Replacing desktops can also bring the latest display technology to your business.
In addition to the touchscreen display on the All-in-One PC, both the All-in-One PC and
Mini Desktop included DisplayPort, which can support higher performance and lower
power monitor displays than the legacy desktop tower we tested. The All-in-One PC also
offered HDMI—either DisplayPort or HDMI on the All-in-One PC can be used to add a
second display.

Replacing desktops can also boost your business with the latest in wireless
technology. The All-in-One PC and Mini Desktop both included Intel Dual Band Wireless-
AC 7260 cards, while the legacy desktop tower we tested did not include a wireless card.
Replacing a fleet of legacy desktop towers without wireless cards provides more
flexibility by removing the requirement of an Ethernet port and cable for each desktop.

Save workspace with All-in-One and Mini form factors
New desktops are available with the latest Intel technology in improved form
factors that take up less workspace than big desktop towers. As Figure 9 shows, the All-
in-One PC and Mini Desktop required significantly less workspace than the legacy
desktop tower in our study—59 and 60 percent less square inches, respectively. Note:
For more details on how we calculated workspace for the three systems, see Appendix
C.

18 The starting price ($1,598) + three-year ProSupport Service brought the price to $1,677.57 for non-touch-enabled display with
Intel Core i5 processor and 8 GB memory for the All-in-One PC. The starting price (including three-year ProSupport Service) for the
All-in-One PC with the same processor and memory and touch-enabled display was $1,863.29 via
www.dell.com/us/business/p/optiplex-9030-aio/fs?pf=v on 12/19/2014.

1% A minute a day, valued at $9.72 ($350/36), per month could provide payback for a $186 cost in 19.1 months.

20 Note: We tested the All-in-One PC installed with Windows 7 so that system configuration matched closely to the legacy desktop
tower. The All-in-One PC and Mini Desktop are available with either Windows 7 or Windows 8.1.
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New form factors mean workspace savings
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As Figure 10 shows, the workspace savings that replacing desktops can bring
your business can have an enormous impact at scale. For example, a business replacing
10,000 legacy desktop towers with 10,000 new Mini Desktops could save 7,708 sq. ft. of
valuable workspace.

Significant workspace savings
with desktop replacement
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Figure 10: Workspace saved in square
feet when replacing a fleet of legacy
desktop towers with Mini Desktops.

Surface area saved (square feet)

0 20,000 40,000 60,000 80,000 100,000
Number of desktops

CONCLUSION

Replacing an aging desktop fleet is an important investment in your business.
Faster and more reliable systems that offer the latest technology provide your
employees an opportunity to be more productive with less waiting while they work.
New desktops also benefit your IT staff, with significantly lower power costs and support

for out-of-band management to reduce costly deskside visits.
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APPENDIX A — SYSTEM CONFIGURATION INFORMATION

Figure 11 details the systems we used in our tests.

System All-in-One PC Mini Desktop Legacy Desktop Tower
General

Number of processor packages 1 1 1

Number of cores per processor 4 4 2

Number of hardware threads per 1 1 1

core

Total number of processor threads 4 4 )

in system

System power management policy | Balanced Balanced Balanced

Processor power-saving option EIST EIST EIST

Dimensions (h x | x w in inches)

20.50 x 22.25 x 8.50

1.50x7.38 x7.19

17.63 x 17.38 x 7.00

Weight (Ibs.) 24.1 2.5 23.8

CPU

Vendor Intel Intel Intel

Name Core™ i5 Core i5 Core 2 Duo
Model number 4590S 4590T E8400
Stepping Cco Cco EO

Socket type Socket 1150 LGA Socket 1150 LGA Socket 775 LGA
Core frequency (GHz) 3.0/3.7 Turbo 2.0/3.0 Turbo 3.0

Bus frequency DMI2 5 GT/s DMI2 5 GT/s 1,333 MHz

L1 cache 4x32KB+4x32KB 4x32KB+4x%x32KB 2x32KB+2x32KB
L2 cache 4 x 256 KB 4 x 256 KB 6 MB

L3 cache 6 MB 6 MB N/A

Platform

Vendor and system name

Dell™ OptiPlex™ 9030
All-in-One

Dell OptiPlex 9020
Micro

HP Compaq 8000 Elite
Convertible Minitower

Motherboard model number

OVNGWR

0Y5DDC

3647h

Motherboard chipset

Intel Q87

Intel Q87

Intel Q45/Q43

BIOS name and version

Dell AO3 (09/15/2014)

Dell A2 (08/11/2014)

Hewlett-Packard
786G7v01.13
(07/20/2011)

AMT Version

5.2.50

9.1.0

9.1.0
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System All-in-One PC Mini Desktop Legacy Desktop Tower
Memory module(s)
Samsung® Hyundai Electronics Samsung
Vendor and model number M471B5173DB0-YKO HMT41GS6BFR8A-PB M378B5673EH1-CHI
Type PC3-12800 PC3-12800 PC3-10600
Speed (MHz) 1,600 1,600 1,333
Speed running in the system (MHz) | 1,600 1,600 1,066
Timing/Latency (tCL-tRCD-RP- 11-11-11-28 11-11-11-28 7-7-7-20
tRASmMIn)
Size (MB) 4,096 8,192 2,048
Number of memory module(s) 2 1 2
Total amount of system RAM (GB) | 8 8 4
Channel (single/dual) Dual Single Dual
Hard disk
Vendor and model number Seagate® ST500LT012 Samsung PM851 SSD Seagate ST3320418AS
Number of disks in system 1 1 1
Size (GB) 500 128 320
Buffer size (MB) 16 N/A 16
RPM 5,400 N/A 7,200
Type SATA 6.0 Gb/s SATA 6.0 Gb/s SATA 3.0 Gb/s
Int.eI 8 Series:/C220 Int.eI 8 Series./C220 Intel Express Chipset
Controller itllglset Family SATA gljllglset Family SATA SATA RAID Controller
Driver Intel 12.8.7.1000 Intel 13.0.0.1098 Intel 10.1.0.1008
(10/18/2013) (02/05/2014) (11/06/2010)
Operating system
Name Windows 7 Windows 7 Windows 7
Professional x64 Professional x64 Professional x64
Build number 7600 7600 7600
Service Pack 1 1 1
File system NTFS NTFS NTFS
Kernel ACPI x64-based PC ACPI x64-based PC ACPI x64-based PC
Language English English English
Microsoft DirectX® version 11 11 11

Change your desktops, change your business
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System

All-in-One PC

Mini Desktop

Legacy Desktop Tower

Graphics

Vendor and model number

Intel HD Graphics 4600

Intel HD Graphics 4600

Intel GMA 4500

Type Integrated Integrated Integrated
. Intel HD Graphics Intel HD Graphics Intel 4 Series Express

Chipset . . . .
Family Family Chipset Family

BIOS version 2179.5 2179.1 2066.0

Total available graphics memory 1696 1,696 1,695

(MB)

Dedicated video memory (MB) 64 64 64

System video memory (MB) 0 0 0

Shared system memory (MB) 1,632 1,632 1,631

Resolution 1,920 x 1,080 1,920 x 1,080 1,920 x 1,080

Driver Intel 10.18.10.3412 Intel 10.18.10.3412 Intel 8.15.10.2413
(01/29/2014) (01/29/2014) (06/03/2011)

Sound card/subsystem

Vendor and model number

Realtek® High
Definition Audio

Realtek High Definition
Audio

Realtek High Definition
Audio

Driver

Realtek 6.0.1.6053
(10/16/2014)

Realtek 6.0.1.6032
(04/25/2014)

Realtek 6.0.1.6383
(05/31/2011)

Ethernet

Vendor and model number

Intel Ethernet
Connection 1217-LM

Intel Ethernet
Connection 1217-LM

Intel 82567LM-3
Gigabit Controller

Intel 12.12.50.4

Intel 12.12.50.7205

Intel 12.10.13.0

Driver (06/12/2014) (07/31/2014) (12/16/2013)
Wireless
Intel Dual Band Intel Dual Band
Vendor and model number Wireless-AC 7260 Wireless-AC 7260 N/A
. Intel 17.0.5.8 Intel 17.0.5.8
Driver (06/18/2014) (06/18/2014) N/A
Optical drive(s)
Vendor and model number TSSTcorp SU-208FB N/A HP TS-H653R
Type DVD-RW N/A DVD-RW
USB ports
Number 8 6 10
Type 3.0 3.0 2.0
Media card reader,
Other DisplayPort, DisplayPort N/A
1 x HDMl In,
1 x HDMI Out
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System All-in-One PC Mini Desktop Legacy Desktop Tower

Monitor

Model Dell All-in-One Touch Dell P2314H ViewSonic® VG730m
Display

LCD type Backlit LED Backlit LED SXGA LCD

Screen size 23" 23" 17"

Refresh rate (Hz) 60 60 60

Maximum resolution 1,920 x 1,080 1,920 x 1,080 1,280 x 1,024

Figure 11: Detailed information for our test systems.

Figure 12 describes the configuration of the server that we used to access the desktops for management tasks.

System Dell PowerEdge R620
Power supplies

Total number 2

Vendor and model number Dell D750E-S1
Wattage of each (W) 750

Cooling fans

Total number 7

Vendor and model number Delta® GFC0412DS
Dimensions (h x w) of each 1-1/2" x 1-3/4"
Volts 12

Amps 1.82

General

Number of processor packages 2

Number of cores per processor 8

Number of hardware threads per core 2

System power management policy Default

CPU

Vendor Intel

Name Xeon®

Model number E5-2660

Socket type LGA 2011

Core frequency (GHz) 2.20

Bus frequency 8

L1 cache 32 KB + 32 KB (per core)
L2 cache 256 KB (per core)
L3 cache 20 MB

Platform

Vendor and model number

Dell PowerEdge™ R620

BIOS name and version

Dell 2.4.3 (10/10/2014)

BIOS settings

Default
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System

Dell PowerEdge R620

Memory module(s)

Total RAM in system (GB) 128

Vendor and model number Micron® MT36KSF1G72PZ
Type PC3-12800R

Speed (MHz) 1,600

Speed running in the system (MHz) 1,600

Timing/Latency (tCL-tRCD-tRP-tRASmin) 9-9-9-24

Size (GB) 8

Number of RAM module(s) 20

Chip organization Double-sided

Rank Dual

Operating system

Name Microsoft Windows Server® 2012 R2 Datacenter
Build number 9600

File system NTFS

Kernel 6.2.9600.16452

Language English

RAID controller

Vendor and model number

Dell PERC H710P Mini

Firmware version

21.3.1-0009 06/23/2014

Driver version

6.802.21.00 08/27/2014

Cache size (MB) 1,024

Local storage

Vendor and model number Seagate ST9900806SS
Number of drives 4

Size (GB) 900

RPM 10K

Type SAS

Ethernet adapters

Vendor and model number

Intel Gigabit 1350 4-port

Type Integrated
Driver 12.11.97.1 (08/13/2014)
USB 2.0 ports 4

Figure 12: Detailed information for our test server.
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APPENDIX B— HOW WE CALCULATED OVERALL SYSTEM PERFORMANCE

We included the following benchmarks in our performance/productivity calculation:

e HDXPRT 2012

e PCMark® 8 Work workload

e SYSmark® 2014
e 3DMark® Ice Storm

e 3DMark Ice Storm Extreme

We ran the five benchmarks on the All-in-One PC, Mini Desktop, and legacy desktop tower, repeating each test

three times. For our calculations, we selected the median of the three results for each benchmark and system. We

calculated the percentage wins for the All-in-One PC and Mini Desktop versus the legacy desktop tower on each

benchmark. The All-in-One PC and Mini Desktop outperformed the legacy desktop tower on all five benchmarks.

We calculated system performance by taking the geometric mean of the percentage wins; that gave us a 145.3

percent system performance improvement for the All-in-One PC versus the legacy desktop and a 114.1 percent system

performance improvement for the Mini Desktop (see Figure 13).

All-in-One PC Mini Desktop G )
Tower
% %
Score improvement Score improvement Score
over legacy over legacy
desktop tower desktop tower
HDXPRT (Create HD score) 229 129% 193 93% 100
SYSmark (Overall Rating) 1,417 133% 1,334 120% 607
PCMark (Work Score) 3,015 29%) 3,093 32%)| 2,341
3DMark Ice Storm (Median) 57,050 361%)| 40,258 225%| 12,385
3DMark Ice Storm Extreme (Median) 34,812 360% 25,834 241% 7,566
Geometric mean of percentage wins 145.3% 114.1%

Figure 13: System performance improvement based on our benchmark testing.
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APPENDIX C—- HOW WE CALCULATED WORKSPACE

Figure 14 shows the dimensions for the three systems and the workspace savings for the All-in-One PC and Mini
Desktop. The base of the All-in-One PC was roughly the same size as the 9" circular base of the monitor that we paired
with the legacy desktop tower. The legacy desktop tower chassis (17.6” x 17.4" x 7.0") took up 121.7 square inches of
desk space. The circular base of the monitor added 63.6 square inches, for a total footprint of 185.3 square inches. With
a footprint of 76.5 square inches, the All-in-One PC was 108.8 square inches smaller than the legacy desktop tower—a
savings of 59 percent.

The Mini Desktop chassis (1.5” x 7.4" x 7.2") took up 11.1 square inches of desk space. We used monitors with
similar footprints for the Mini Desktop (62.2 square inches) and the legacy desktop tower (63.6 squares inches).
Including the monitors, the footprint of the Mini Desktop was 111.0 square inches smaller than the footprint of the
legacy desktop tower—a savings of 60 percent.

Monitor System Total
Total
Length x Area Length x Area Advantage
. . Area Advantage
width (sq. width (sq. vs. legacy
(inches) inches) (inches) inches) (sq. (sg. inches) (%)
inches) )
All-in-One PC 8.5x9.0 76.5 76.5 108.8 59%
Mini Desktop 7.1x8.9 632 | 7.4x15 11.1 74.3 111.0 60%
(on its narrow side)
Legacy Desktop Tower 9.0 636 | 17.4x7 121.7 185.3
(circular base)

Figure 14: Dimensions of the three systems and the workspace savings for the All-in-One PC and Mini Desktop.
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APPENDIX D — HOW WE TESTED

Measuring system performance

HDXPRT 2012
Setting up the test

1. Insert the HDXPRT v1.1 DVD-ROM into your DVD drive.

2. At the HDXPRT Install screen, click Install HDXPRT.

3. Accept the HDXPRT end-user license agreement.

4. After the setup is complete, select Yes, | want to restart my computer now, and click Finish.
Running the test

1. On the desktop, click the HDXPRT 2012 shortcut.

2. Click Run HDXPRT.

3. Enter a test name, choose 3 iterations, and click Run.

4. The Results Screen automatically appears at the end of a successful run.

BAPCo® SYSmark 2014 v1.0.1.21

Antivirus software conflicts
SYSmark 2014 is not compatible with any virus-scanning software, so we uninstalled any such software that was

present on the desktop PCs before we installed the benchmark.

Pre-installed software conflicts
SYSmark 2014 installs the following applications, which its test scripts employ:

e Adobe® Acrobat® Xl Pro

e Adobe Photoshop® CS6 Extended
e Adobe Premiere® Pro CS6

e Google Chrome™

e  Microsoft Excel® 2013

e Microsoft OneNote® 2013

e Microsoft Outlook® 2013

e  Microsoft PowerPoint® 2013
e Microsoft Word 2013

e Trimble® SketchUp® Pro 2013
e WinZip® Pro 17.5

Setting up the test

1.

©o NV AW

Disable the User Account Control.

Click Start->Control Panel.

At the User Accounts and Family Safety settings screen, click Add or remove user account.
At the User Account Control screen, click Continue.

Click Go to the main User Accounts page.

At the Make changes to your user account screen, click Turn User Account Control on or off.
At the User Account Control screen, click Continue.

Uncheck Use User Account Control to help protect your computer, and click OK.

At the You must restart your computer to apply these changes screen, click Restart Now.

10 Purchase SYSmark 2014 v1.0.1.21 from bapco.com/products/sysmark-2014 and install with default settings.
11. To launch SYSmark 2014, double-click the desktop icon, and select Configuration.
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12.

Select all options, and click Save.

Running the test

PwWNPE

Double-click the desktop icon to launch SYSmark 2014.

Make sure Office Productivity, Media Creation, and Data/Financial Analysis are selected.

Enter a Project name.

Select 3 Iterations, check the box beside Conditioning Run and beside Process Idle Tasks, and click Run
Benchmark.

When the benchmark completes and the main SYSmark 2014 menu appears, click Save FDR to create a
report.

Futuremark® PCMark 8 v2.3.293
Setting up the test

1.
2.
3.
4.

Download the PCMark 8 installer exe Windows package from www.futuremark.com/benchmarks/pcmarks.
Double-click the PCMark installer exe file to install PCMark 8 with the default options.

Click the PCMark 8 desktop icon to launch PCMark 8. Enter the registration code, click Register, and click OK.
Exit PCMark 8.

Running the test
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3DMark

Boot the system and type CMD to bring up a command prompt.

To open App options, right-click the Command Prompt app.

Click Run as administrator.

TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.

After the command completes, wait 5 minutes before running the test.

Double-click the PCMark 8 desktop icon to launch the benchmark.

Select the Home test suite.

Click Run Conventional.

. When the benchmark run completes, record the results.
. Shut down the system.
. Complete steps 1 through 11 two more times for the Home test suite, and report the median of the three

runs.

. After completing the three runs of the Home test suite, perform steps 1 through 12 for the Creative, Work,

Storage, and Application suites.

Installing 3Dmark v1.4.828

1.
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Download the 3DMark installer from www.futuremark.com/benchmarks/3dmark/all.

To install 3DMark with the default options, double-click the 3DMark installer exe file.

At the Welcome screen, click Next.

At the License Agreement screen, click | accept the terms of the license agreement, and click Next.

At the Setup Type screen, click Express, and click Next.

At the Ready to Install the Program screen, click Install.

At the Setup Complete screen, click Finish.

To launch 3DMark, double-click the 3DMark desktop icon. Enter the registration code, and click Register.
Exit 3DMark.

Running 3DMark v1.4.828

1.

Boot the system and bring up a command prompt:
a. Type CMD into the Start menu search bar.
b. Right-click the Command Prompt app.
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c. Click the Run as administrator button.
Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
To launch the benchmark, double-click the 3DMark desktop icon.
At the 3DMark Benchmark screen, click Run Ice Storm Unlimited.
When the benchmark run completes, record the results.
Repeat steps 6 and 7, except run Ice Storm Extreme.
Complete steps 1 through 8 two more times, and report the median of the three runs.
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Measuring power consumption
Test requirements
e ExTech 380801 True RMS Power Analyzer
e PassMark® BurninTest Professional
e Thermometer
Measuring system temperature while idle and under load

Setting up the test
1. Using a power strip, plug the system under test (and monitor if used) into the ExTech.

2. Plug the ExTech into its own circuit.

3. On the system used to monitor the ExTech, open the Power Analyzer.

4. From the drop-down Option menu, select Sample Rate.

5. For the sample rate, enter 1.0, and select OK.

6. On the systems under test, set the power plan to the manufacturer’s default setting. Set the display
brightness to 100 percent:

a. Click Start.

b. Inthe Start menu’s quick search field, type Power Options

c. Move the Screen brightness slider all the way to the right.

7. Set the remaining power plan settings as follows:
e Dim the display: Never
e Turn off the display: Never
e Put the computer to sleep: Never

8. Disable the screen saver.

9. Download PassMark Burnln Test Professional V7 from www.passmark.com/products/pt.htm.

10. To run setup, double-click bitpro_x64.exe.

11. At the Welcome screen, click Next.

12. Accept the license agreement, and click Next.

13. At the Choose Install Location screen, accept the default location of C:\Program Files\BurnInTest, and click
Next.

14. At the Select Start Menu Folder screen, click Next.

15. At the Ready to Install screen, click Install.

16. At the Completing the BurninTest Setup Wizard screen, deselect View Readme.txt, and click Finish to launch
PerformanceTest.

17. At the Purchasing information screen, copy and paste the Username and key, and click Continue.

18. At the Key accepted screen, click OK.
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19.
20.
21.
22.
23.

From the Configuration menu item, select Test selection and duty cycles.

Change the Auto Stop After field to 180.

Select CPU, 2D Graphics, 3D Graphics, RAM, and Disk(s), and deselect all other subsystems.

Set load to 100, and click OK.

From the Configuration menu item, select Test Preferences and set or verify the following by clicking on
each tab:

e Disk: select C: drive

e logging: select Turn automatic logging on

e 2D Graphics: select All available Video Memory

e 3D Graphics: defaults

e RAM: select Multi-Process Torture Test

Running the test
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Boot the system and bring up an administrative command prompt:

TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks

Do not interact with the system until the command completes.

After the command completes, wait 5 minutes before running the test.

On the ExTech power monitor, enter a name for the test run.

Report the room temperature, and in the ExTech Power Analyzer window, click Start Recording

After 30 minutes, record the room temperature.

After 1 hour, record the room temperature and in the ExTech Power Analyzer window, click Stop Recording.
Record the average watts of the run as Idle Power consumption.

. Record the average of the recorded room temperatures as the Idle Room Temperature.

. On the ExTech power monitor, enter a name for the Under Load test run.

. Double-click the PassMark BurninTest desktop icon.

. In the BurnInTest V7.0 Pro screen, click Start Selected Tests.

. Report the room temperature, and in the ExTech Power Analyzer window, click Start Recording.

. After 30 minutes, record the room temperature.

. After 1 hour, record the room temperature, and in the ExTech Power Analyzer window, click Stop Recording.
. Record the average watts of the run as Under Load Power Consumption.

. Record the average of the recorded room temperature as the Under Load Room Temperature.

. Power the system down and let it rest for one hour.

. Complete steps 1 through 19 two more times, and report the median of the three Idle and Under Load runs

as well as the average temperature for each median run.

Configuring the SCCM management environment

Starting from our base Microsoft System Center 2012 Configuration Manager build, we configured our

environment to test KVM Remote Control capability on our target clients. Figure 15 shows our isolated testing

environment, which comprised of one Dell PowerEdge R620 server running Windows Server 2008 R2 Hyper-V® with four

virtual machines. Before configuration, we installed all available Windows updates on our clients and joined each

desktop to the test.local domain. We created Active Directory accounts for AMT provisioning and installed Intel Setup

and Configuration Software (Intel SCS). Next, we provisioned the desktops using Configurator, provided by Intel, to apply

our custom management profile from SCS to each client’s management engine. We provide detailed steps below for

each of these procedures. Finally, we installed vendor-specific vPro management tools, which we used to connect to the

All-in-One PC and Mini Desktop using KVM Remote Control to complete our timed testing.
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Roles Installed
Description Co:gr::er Operating system Assigned IP | vCPU | vRAM
Windows Server Active Directory,
Domain controller dc.test.local Domain Controller, 192.168.1.10 | 1 8 GB
2008 R2 Standard
DHCP
Certificate authority | ca.test.local Windows Server. Certification Authority 192.168.1.15 | 1 8 GB
2008 R2 Enterprise
Windows Server SQL Server 2012
Database server db.test.local 5008 R2 Standard Enterprise 192.168.1.20 | 1 16 GB
Windows Server System Center 2012
Management server | cm.test.local 5008 R2 Standard (Sisfflguratmn Manager | 192.168.1.50 | 2 16 GB

Figure 15: The details of our isolated testing environment.

Constructing the infrastructure

Creating Active Directory accounts for AMT provisioning

1.
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9.

Log into the Domain Controller using the domain\administrator account.

Open Active Directory Administrative Center.

Under test(local), click New—=>Group.

On the Create Group window, for Group name, use Kerberos Admins; for Group type, use security.
Add Kerberos Admins as a member of the Domain Admins group.

Add the computer account of the SCCM server to the Kerberos Admins security group.

Create an Organizational Unit for AMT managed systems. We used AMT

Create a security group called AMT

Add the Kerberos Admins group to the AMT security group.

Creating certificate templates for OOB management

1.
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13.

14.

Log into the Windows 2008 R2 Enterprise server designated for Certificate Authority as
domain\administrator.

Click Start->Administrative Tools—> Certification Authority.

Right-click on test-CA-CA, and click Properties.

On the General tab, click View Certificate.

On the Details tab, scroll to and select Thumbprint. Copy the 40-character code displayed in the details. You
will add this information to the AMT BIOS later.

To close the Certificate Authority properties, click OK.

Expand the Certification Authority, and select Certificate Templates.

Right-click Certificate Templates, and select Manage.

Locate Web Server in the list of available certificate templates. Right-click the template, and select Duplicate
Template.

. Select Windows 2003 Enterprise, and click OK.
11.
12.

Change the template name for the AMT Provisioning certificate. We used AMT Provisioning.

On the Subject Name tab, select Build from this Active Directory Information. Select Common Name, and
choose the option UPN.

On the Security tab, add the security group created for the SCCM site server. We used the Kerberos Admin
group. Add the Enroll permission for the security group. Ensure Domain Admins and Enterprise Admins have
Enroll permissions.

On the Extensions tab, select Application Policies, and click Edit.
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15. Click Add. Click New. Type AMT Provisioning forthe name,and2.16.840.1.113741.1.2.3as
the Object Identifier. Click OK.

16. Ensure AMT Provisioning and Server Authentication are listed, and click OK.

17. Click OK to close the template properties.

18. Right-click the AMT Web Server Certificate template, and select Duplicate Template.

19. Select Windows 2003 Enterprise, and click OK.

20. Change the template name for the AMT Web Server Certificate. We used AMT Web Server
Certificate Template.

21. On the General tab, choose the option Publish Certificate in Active Directory.

22. On the Subject Name tab, select Supply in the request.

23. On the Security tab, ensure Domain Admins and Enterprise Admins have Enroll permissions.

24. To close the template properties, click OK.

25. In Certification Authority, navigate to Certificate Templates.

26. For both the AMT Provisioning Template, and the AMT Web Server Certificate Template, repeat the
following steps:

27. Right-click the central panel, and select New—> Certificate Template to Issue.

28. Select the AMT Provisioning Template.

29. Click OK.

30. Log into the management server as domain\administrator.

31. Click Start=>Run. Type mmc and press Enter.

32. In the mmc console, click File=>Add/Remove Snap-in...

33. Select Certificates, and click Add. Select Computer account. Click Next.

34. Select Local computer, and click Finish.

35. Click OK.

36. Expand Certificates (Local Computer)—> Personal—> Certificates.

37. In the right panel, click More Actions—> All Tasks>Request a new certificate...

38. Click Next.

39. Accept the defaults, and click Next.

40. Select the new AMT Provisioning certificate. Click Enroll.

41. Click File=>Add/Remove Snap-in...

42. Select Certificates, and click Add. Select Computer account. Click Next.

43. Select My user account, and click Finish.

44, Click OK.

45, Expand Certificates> Personal-> Certificates.

46. In the right panel, click More Actions=>All Tasks=>Request a new certificate...

47. Click Next.

48. Accept the defaults, and click Next.

49. Select the new AMT Provisioning certificate. Click Enroll.

50. Click File>Add/Remove Snap-in...

51. Select Certificates, and click Add. Select My user account. Click Next.

52. Select Local computer, and click Finish.

53. Click OK.

54. Expand Certificates — Current User->Personal—> Certificates.

55. From Certificates (Local)=>Personal> Certificates, click and drag the certificate created using the AMT
Provisioning template into Certificates — Current User-> Personal—> Certificates.

56. Click Close.
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Installing Intel Setup and Configuration Software (SCS) 9.1

1.
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10.
11.
12.
13.
14.

Download IntelSCS_9.1.zip from downloadcenter.intel.com/Detail Desc.aspx?DwnldID=20921.
Extract the contents to C:\IntelSCS_9.1.

Browse to C:\IntelSCS_9.1\IntelSCS\RCS.

Run IntelSCSInstaller.exe.

At the Welcome screen, click Next.

Select | accept the terms of the license agreement, and click Next.

Check the Boxes for Remote Configuration Service (RCS), Database Mode, and Console.

Enter the credentials of the Domain account that will run the service. We used
test.localladministrator. Click Next.

Select db.test.local as the location for the SCS database. This information may populate automatically. Select
Windows Authentication, and click Next.

On the Create Intel SCS Database pop-up, click Create Database.

On the confirmation screen, click Close.

On the confirmation screen, leave the default Installation Folder, and click Install.

Once the installation is complete, click Next.

Click Finish.

Setting up AMT provisioning with Intel SCS Remote Configuration Service

Creating the configuration profile
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10.
11.
12.
13.
14.
15.

16.

17.

18.
19.
20.
21.
22.

On the management server, launch the Intel Setup and Configuration Console.

Click Profiles.

To construct a profile for deployment, click New.

For Profile Name, enter a description of the target clients. We used inteltest. Click OK.

On the Getting Started Screen, choose Configuration / Reconfiguration.

On the Optional Settings screen, choose the options Active Directory Integration, Access Control List (ACL),
and Transport Layer Security (TLS), and click Next.

On the AD Integration screen, browse for the OU created for the AMT managed devices. We used OU=AMT,
DC=test, DC=local. Check the box for Always use host name, and click Next.

On the Access Control List screen, click Add.

Select Active Directory User/Group. Click Browse.

Add Kerberos Admin, Domain Admins, or other administrative users groups. Click OK.

For Access Type, select Remote.

Choose the option for PT Administration. Click OK.

Click Next.

On the TLS screen, from the drop-down menu, select the Enterprise Certificate Authority, ca.test.local.
Select the Server Certificate Template to be used to generate certificates for the AMT devices. We selected
AMTWebServerCertificate. Click Next.

On the System Settings screen, choose the options Web Ul, Serial Over LAN, IDE Redirection, and KVM
Redirection.

Select Use the following password for all systems. Enter the password for use after provisioning is complete.
We used P@sswOrd

Click KVM Settings...

Enter the RFB Password for KVM sessions. We used P@sswOrd

Enter the MEBX password. We used P@sswOrd

Uncheck User Consent required before beginning KVM session, and click OK.

Choose the options Enable Intel AMT to respond to ping requests and Enable Fast Call for Help (within the
enterprise network).
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23. To Edit IP and FQDN settings, click Set.

24. In the Network Settings window, select Use the following as the FQDN, and choose Primary DNS FQDN from
the drop-down menu.

25. Choose the option, the device and the OS will have the same FQDN (Shared FQDN).

26. Select Get the IP from the DHCP server.

27. Select Update the DNS directly or via DHCP option 81. Click OK.

28. Click Next.

29. Click Finish.

Configuring the clients
Repeat these steps for each client.

Reserving an IP address in DHCP

On the Domain Controller, run dhcpmgmt.msc.

Expand FQDN-> IPv4->Scope, and click Reservations.

Click More Actions, and click New Reservation.

For Reservation Name, enter the host name of the target client.
Enter an IP address to reserve.

Enter the MAC address of the target client’s Ethernet port.

7. Click Add.

Configuring policy on the target client
1. Log onto the target client using domain\administrator.
Download and apply applicable driver packages from the manufacturer’s Web site.
Open Windows Firewall with Advanced Security.
Click Firewall Properties.
On the Domain Profile, Private Profile, and Public Profile tabs, set the Firewall state to Off. Click OK.
Set the host name and IP of each virtual machine as described above.
Run lusrmgr.msc.
Select Groups.
. Right-click Administrators, and click Properties.
10. Click Add.
11. Select Object Types, check the box for Computers, and click OK.
12. Disable the wireless adapter.
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Configuring the Configuration Manager Client
1. On the management server, navigate to Program Files=> Microsoft Configuration Manager folder.
2. Copy the Client folder to the target client.
3. Onthe target client, run ccmsetup.exe. This task will run in the background and will take a few minutes to
complete.
4. In Control Panel, open Configuration Manager.
5. On the Site tab, click Configure Settings.
6. For Currently assigned to site code, enter PTL, and click Apply.
7. Inthe Actions panel, run the User Policy Retrieval & Evaluation Cycle and the Machine Policy Retrieval &
Evaluation Cycle.
8. After a few minutes, the Actions panel will populate with more tasks. Run each one of the tasks.
Adding the enterprise certificate authority to the AMT trusted root certification authorities
1. Power on the target client.
2. During POST, press CTRL-P to enter the Intel Management Engine BIOS settings.
3. When prompted for a password, type the default password admin
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4. Provide and confirm a new password. We used P@sswOrd

5. Select Intel AMT Configuration. Press Enter.

6. Select SOL/IDER/KVM.

7. All features should be Enabled. To exit the menu, press Esc.

8. Select User Consent.

9. Change User Opt-in to None.

10. Change Opt-in Configurable from Remote IT to Disabled. To exit the menu, press Esc.

11. Change Password Policy to During Setup and Configuration.

12. Select Network Setup.

13. Select Intel ME Network Name Settings.

14. For Host Name, use the same host name used for the operating system.

15. For Domain Name, enter the domain name. We used test.local

16. For Shared/Dedicated FQDN, select Shared.

17. For Dynamic DNS Update, select Enabled. Press Esc to exit the menu.

18. Select Remote Setup and Configuration. Press Enter.

19. On Provisioning Server IPv4/IPv6, enter the IP address of the system center server. We used
192.168.1.50

20. For Provisioning Server FQDN, enter the FQDN of the management server. We entered cm. test.local.
For port number we used 9971

21. Select TLS PKI.

22. Select PKI DNS Suffix, and type the FQDN suffix. We used test.local. Press Enter.

23. Select Manage Hashes.

24. To add a new hash, press Insert.

25. Enter a descriptive name for the Enterprise Certificate Authority. We used test.local CA

26. Press Enter.

27. Following the syntax example provided in the prompt, enter the 40-character thumbprint previously copied
from the Enterprise CA root certificate. Press Enter.

28. To set the hash certificate as active, press Y. test.local CA will appear in the list of trusted root authorities
and should be active.

29. To return to the AMT Configuration Menu, press Esc.

30. Select Activate Network Access. To confirm, press Y.

31. To exit, press Esc until prompted. To confirm exit, press Y.

Executing the remote configuration script on the AMT managed client
1. Loginto the AMT managed target client as domain\administrator.
2. Copy the \Configurator folder from the SCS_9.1 directory located on the management server to C:\ on the
local host.
3. Openacommand prompt as administrator.
Type cd C:\Configurator and press Enter.
5. Execute the following command:
ACUConfig.exe /lowsecurity /output console /verbose ConfigViaRCSOnly
cm.test.local inteltest
6. The Configurator utility will contact the Remote Configuration Service and apply the settings configured in
the inteltest profile.
Setting up AMT discovery in SCCM
1. Onthe management server, open the SCCM Management Console. Locate the target client in the Devices
panel.
2. Right-click the headings bar in the Devices panel, and check the entries for AMT Status and AMT Version.

e
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3. Right-click the server, and select Manage Out of Band—> Discover AMT Status. Click OK.

In the Home menu at the top of the panel, click Refresh.

5. The Client, Site Code, and Client Activity fields will populate. The AMT Status will change to Externally
provisioned.

E

Measuring the time to open a KVM session with the All-in-One PC and Mini Desktop

1. Onthe management server, from the Windows taskbar, open Dell Command | Intel vPro Out of Band and
start the timer.

Select Operations.

Select KVM Connect.

On the KVM Connect screen, select the target client, and click Connect.

The KVM will window will appear and connect automatically. When the login screen is visible, stop the
timer.

6. Complete steps 1 through 5 two more times, and report the median of the three runs.

vk wn

APPENDIX E—- BENCHMARK INFORMATION

About HDXPRT 2012
The High Definition Experience & Performance Ratings Test (HDXPRT) 2012 is a benchmark that evaluates the

capabilities of PCs in consumer digital media uses, divided into the following categories:

e Media Organizer

e Media Creator

e Photo Blogger

e Video Producer

e Music Maker

For more information on HDXPRT 2012, see
principledtechnologies.com/benchmarkxprt/whitepapers/2012/HDXPRT 2012 White Paper.pdf.
About BAPCo SYSmark 2014

According to BAPCo, “SYSmark 2014 is an application-based benchmark that reflects usage patterns of business

users in the areas of office productivity, media creation, and data/financial analysis.” The benchmark features notable
applications from these fields. SYSmark 2014 generates a score from the times the tested system takes to complete each
individual operation in each scenario. For more information on this benchmark, see bapco.com/products/sysmark-2014.

About Futuremark PCMark 8 v2.2.282

According to Futuremark, “PCMark 8 is the latest version in our series of industry standard PC-benchmarking

tools.” PCMark 8 evaluates the performance of PCs from tablets to desktops by using real-world tasks and applications.
Applications are divided into scenarios that reflect common usage in different capacities. For our testing, we used the
Work portion of the benchmark, which offers workloads that test a system's ability to perform basic office work tasks,
such as writing documents, browsing Web sites, creating spreadsheets, and using video chat.
About Futuremark 3DMark (2013) v1.4.778

Futuremark 3DMark v1.4.778 is a collection of benchmarks designed to rate the graphics performance of
smartphones, tablets, notebooks, laptops, desktops, or high-performance gaming PCs. 3DMark includes benchmarks

designed for Windows, Apple®, and Android™ devices. The Ice Storm portion of 3DMark includes 720p graphics tests to
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measure GPU performance and a physics test to stress CPU performance. Ice Storm is available for Windows, iOS, and
Android smart phones and tablets. It uses a DirectX® 11 feature level 9 for Windows and OpenGL® ES 2.0 for iOS and
Android systems. Ice Storm Extreme increases the rendering resolution to 1080p and uses higher quality textures and

post-processing effects in the Graphics tests.
For more information on 3DMark, see www.futuremark.com/benchmarks/3dmark.
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Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER,
PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND
ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE.
ALL PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED
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DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES,
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